SPICE Introduction Laboratory

Dr. Lynn Fuller
Electrical and Microelectronic Engineering
Rochester Institute of Technology
82 Lomb Memorial Drive
Rochester, NY 14623-5604

Email: Lynn.Fuller@rit.edu
Dr. Fuller’s Webpage: http://people.rit.edu/lffeee
MicroE Webpage: http://www.rit.edu/kgcoe/microelectronic/
This PowerPoint module has been published using Adobe Presenter. Please click on the Notes tab in the left panel to read the instructors comments for each slide. Manually advance the slide by clicking on the play arrow or pressing the page down key.
Introduction to SPICE Laboratory

OUTLINE

SPICE Introduction
PSpice Lite, OrCAD PSpice and LTSPICE
Simple Example
Resistor and Capacitor Divider Circuit
DC Analysis
AC Analysis
Transient Analysis
Diode Example
Help   - Setting Initial Condition (.IC)
       - Parameter Sweeps (.Param)
       - Include Files (.Inc)

References
INTRODUCTION

SPICE (Simulation Program for Integrated Circuit Engineering) is a general-purpose circuit simulation program for non-linear DC, non-linear transient, and linear AC analysis. Circuits may contain resistors, capacitors, inductors, mutual inductors, independent voltage and current sources, four types of dependent sources, transmission lines, switches, and several semiconductor devices: including diodes, BJTs, JFETs, MESFETs, and MOSFETs. Circuits with large numbers of all types of components can be simulated.

SPICE input files and output files are simple text files (e.g. name.txt)

Input files include a TITLE, circuit description NET LIST, analysis directives (COMMANDS), and lists of other text files to include (INC) such as model libraries (LIB) and an END command.
PSPICE Lite 9.2 is one of the OrCAD family of products, from Cadence Design Systems, Inc., offering a complete suite of electronic design tools. It is free and includes limited versions of OrCAD Capture, for schematic capture, PSPICE for analog circuit simulation and Pspice A/D for mixed analog and digital circuit simulation. PSPICE Lite 9.2 is limited to 64 nodes, 10 transistors, two operational amplifiers and 65 primitive digital devices. See page 35 (xxxv) of the PSPICE Users Guide.

The Electrical and Microelectronic Engineering department at RIT provides a full version of Cadence Design Systems, Inc. PSPICE on the computers in the department laboratories. It uses Allegro Design Capture (also from Cadence) for schematic capture.

LT SPICE – is a free SPICE simulator with schematic capture from Linear Technology. It is quite similar to PSPICE Lite but is not limited in the number of devices or nodes. Linear Technology (LT) is one of the industry leaders in analog and digital integrated circuits. Linear Technology provides a complete set of SPICE models for LT components. (This is a good choice for your home computer.)
The input file for SPICE is generated automatically from the schematic capture software. In the old days the input file was created by hand as a simple text file. SPICE can still run using a simple text file as the input but today most users prefer to use schematic capture software to create the input file.

SPICE treats upper case and lower case the same (it is not case sensitive)
EXAMPLE OF SIMPLE SPICE INPUT FILE

DR FULLER - SIMPLE EXAMPLE TITLE
* THE FIRST LINE IS THE TITLE
* LINES THAT START WITH * ARE COMMENT LINES AND DO NOTHING
* UPPER AND lower case text ARE TREATED THE SAME
* CIRCUIT IS DESCRIBED BELOW (NET LIST)
R1 1 2 3K ; resistor R1 between node 1 and node 2 has value 3K ohms
R2 1 0 2K
V1 2 0 DC 5 ; Voltage source V1 is a DC source of 5 volts
*
* REQUESTED ANALYSIS (DIRECTIVES OR COMMANDS)
.DC V1 0 5 0.1 ; find all node voltages and branch currents for V1 starting at 0 and
* incrementing by 0.1 volts ending at 5 volts
.PLOT DC V(1); plot voltage at node (1)
*
*.INCLUDE File_name.txt ;(none for this example)
* The last line is the END command
.END
BEFORE YOU START

It might be good to set up some folders for your SPICE projects.

I put a SPICE folder on my desktop and created sub folders for each project, models and other files, lab handouts, etc.
STARTING CADENCE RELEASE 17.2

1. Windows search bar
2. Cadence folder
3. Cadence Release 17.2-2016
4. Cadence Product Choices dialog box

Rochester Institute of Technology
Microelectronic Engineering
NEW PROJECT
BLANK PROJECT

1. Name: Lab1V2
2. Create a new Analog or Mixed A/D project.
3. Location: C:\Users\lfeee\Desktop\EE480 Labs
4. OK
5. Create a blank project
6. OK
Allegro Design Entry CIS – Schematic Capture

Add part
ADD FIVE LIBRARIES

C:/cadence/SPB_17.2/tools/capture/library/pspice

Select:  Analog
         Breakout
         Eval
         Source
         Special

Click to add library
PLACE A RESISTOR ON SCHEMATIC

1. Double click to select

2. Esc to unselect component

3. r return to rotate 90°
To place parts the project needs to be linked to some component libraries. In the PSPICE folder select

C:/cadence/SPB_17.2/tools/capture/library/pspice

ANALOG – resistors, capacitors, inductors, switches, other
BREAKOUT – Many components but most use default
  SPICE models
EVAL – BJT’s, FET’s, Digital Logic, etc., with commercial
  SPICE models
SOURCE – Voltage Sources, Current Sources, etc.
SPECIAL – Directives .IC, .INC, .PARAM, etc.

Design Cache will be automatically created to hold components used in the design. (and design specific part modifications)

Click on component name
Double click on name in parts list to place on schematic
Esc to quit placement of that part
MOSFET, BJT AND DIODE MODELS

Most versions of SPICE have model libraries that can be included with a SPICE input file. You could also create your own models as a simple text file and include that file with a SPICE input file for Orcad PSpice, LTSpice, or Cadence PSpice. Edit the simulation profile under the PSpice Pull down menu, the configure files tab allows text files to be added to the input file. (extension .txt or .inc)

In SPICE a transistor is defined by its model name and associated properties and its model. Its name and associated properties is given in the input file net list. Its model is given in the included library model file or included with the input file as a text file. For example:

```
M2 3 2 0 0 RITSUBN7 L=2U W=16U ad=96e-12 as=96e-12 pd=44e-6 ps=44e-6 nrd=1.0 nrs=1.0
```

part reference name

model name

properties

nodes for drain, gate, source and substrate
NEW SIMULATION PROFILE
**SIMULATION SETTINGS**

- **Analysis Type:** Time Domain (Transient)
- **Run To Time:** 1000ns
- **Start saving data after:** 0 seconds
- **Transient options:**
  - Maximum Step Size: 100ns
  - Skip initial transient bias point calculation (SKIPBP)

Other options available:
- General Settings
- Monte Carlo/Worst Case
- Parametric Sweep
- Temperature (Sweep)
- Save Bias Point
- Load Bias Point
- Save Check Point
- Restart Simulation

[Simulation Settings - test2 window]
ADDING A TEXT FILE

Include files are loaded before the circuit. They can include most valid PSpice commands, such as .PARAM and .FUNC definitions.
SETTING PROBE WINDOW SAME AS LAST PLOT
RIT MOSFET, BJT AND DIODE MODELS

* The Included Model File
*2-15-2009

```
*.MODEL RITSUBN7 NMOS (LEVEL=7
+VERSION=3.1 CAPMOD=2 MOBMOD=1
+TOX=1.5E-8 XJ=1.84E-7 NCH=1.45E17 NSUB=5.33E16 XT=8.66E-8 NSS=3E11
+VTH0=1.0 U0= 600 WINT=2.0E-7 LINT=1E-7
+NGATE=5E20 RSH=1082 JS=3.23E-8 JSW=3.23E-8 CJ=6.8E-4 MJ=0.5 PB=0.95
+CJSW=1.26E-10 MJSW=0.5 PBSW=0.95 PCLM=5
+CGSO=3.4E-10 CGDO=3.4E-10 CGBO=5.75E-10)
*
`.model RITMEMDIODE D IS=3.02E-9 N=1 RS=207
+VJ=0.6 CJO=200e-12 M=0.5 BV=400
`

+RC=1 RB=10 VA=109)
```

More models for RIT components can be found on Dr. Fullers webpage
http://people.rit.edu/lffeee/cmos.htm
Use SPICE for the following examples:

- DC analysis of RC divider circuit shown below
- Transient analysis of RC divider circuit shown below
- AC analysis of RC divider circuit shown below
- Large signal AC analysis of diode/rectifier circuit shown below
Calculate VC

Change the battery to a 3 volt step function and plot VC versus time.

Change the battery to a sinusoidal voltage source and sketch VC versus frequency
DC SPICE ANALYSIS

Rochester Institute of Technology
Microelectronic Engineering

© January 24, 2019 Dr. Lynn Fuller
TRANSIENT ANALYSIS

V1 = 0
V2 = 3
TD = 0
TR = 1n
TF = 1n
PW = 25m
PER = 50m

© January 24, 2019 Dr. Lynn Fuller
AC ANALYSIS
Right click on the diode and select Edit Properties, change implementation from Dbreak (or other) to RITMEMDIODE.

Edit the simulation profile under the PSpice Pull down menu, the configure files tab allows text files to be added to the input file. (extension .txt or .inc) Include the model file shown on pages below or from Dr. Fullers webpage.

More models for RIT components can be found on Dr. Fullers webpage
http://people.rit.edu/lffeee
OUTPUT FILE USING Dbreak DIODE MODEL
OUTPUT USING TWO DIFFERENT DIODE MODELS

Using Dbreak Library Diode Model

Using RITMEMDIODE Diode Model

Why is there a difference in these two results?
*The Library Model File for Dbreak
.model Dbreak D IS=1E-14 RS=0.2 CJO=0.1e-12
*

*The Included Model File for RITMEMDIODE
.model RITMEMDIODE D IS=3.02E-9 N=1 RS=207
+VJ=0.6 CJO=200e-12 M=0.5 BV=400
*

If the model is already in a library linked to the schematic then SPICE will know where to find the model.

If the model is in a text file located some place on your computer then you will need to identify the path to the file. You can include files in the PSPICE simulation settings (under configuration files) or Select .Inc command from the PSPICE special library, place the icon on the schematic, double click and provide the path to the file.
IMPORTING THE INCLUDE FILES INTO CADENCE PSPICE

Text files can be attached to the input file in the SPICE simulation settings, configuration files, or through the .INC directive available in the PSPICE special library.
Cadence introduces SPICE directives through its “Special” Library.

`.IC V((Vin)=5) ;` sets node labeled Vin to 5 volts initially.

Initial condition sets the voltage at a node to a value for DC operating point calculations. Then removes that voltage for subsequent transient or ac analysis. This is useful for circuits such as oscillators to help with start up.
Parameter sweeps allow you to investigate the performance of your circuit for changes in some component parameter such as the value of a resistor or the width of a transistor.

Voltage sources (and other components) are automatically set up such that the voltage is a parameter that can be swept. Resistors (and other components) need to be set up so that their value can be swept.

Cadence PSPICE does this with the parameter directive in the special library.
Select **Parameters**: from the “special” library and put on schematic. Then double click it. Select **New Column**, yes. Give a Name and starting value, Apply.
Return to schematic and change the value of the resistor to \{R_{val}\} Including curly brackets

OK

Where this is the new column name given in the attribute editor
CADENCE PARAMETER SWEEPS

The simulation settings has a primary sweep for V1 and secondary sweep for Rval, using the value list option, giving the results shown.
SETTING COLORS FOR PSPICE WAVEFORM

Tools > Options > Color Settings
CHANGING TRACE WIDTH

After changing Background color to white and foreground to black
Trace > Trace Property > Width
ADD PLOT PLANE, CURSORS, LABELS, ETC.

Add Plot Plane
Add Cursors, Then Freeze
Add Labels

Window > Copy to clipboard > change all colors to black
PSPICE WITH MEASURE COMMANDS

Run SPICE
Select Trace > evaluate measurement

NML, noise margin low, \( \Delta 0 = V_{IL} - V_{OL} = 1.875 - 0.625 = 1.25 \)
NMH, noise margin high, \( \Delta 1 = V_{OH} - V_{IH} = 4.375 - 3.125 = 1.25 \)
MEASUREMENTS FOR OP AMP GAIN
OTHER TRICKS

Saving the Plot Settings:
In the Configuration File select the Plot Tab, select Last Plot

Using node names instead of wires to make connections:
Type n return, Create a node name such as VDD or GND, return. Then place name on a node. Any nodes with the same name are connected. Also easier to add a trace to a plot plane using syntax add>trace V(nodenane)

View and Edit Transistor Properties (attributes)
Right click on a transistor, select edit properties, change values for various properties such as L, W, AD, AS, PD, PS, etc. If you want these properties to be seen on the schematic select Display Name and Value. Select Pivot to change the dialog box from horizontal to vertical orientation.

Changing the Page Size:
May need to be larger for schematics with many transistors.
Select Options>Page size
MORE TRICKS

Short Cuts:  

- Type the letter w to add a wire
- Type the letter r to rotate selected part
- Type the letter n to label node
EXAMPLE - SPICE FOR SRAM READ

This is a schematic of the sense amplifier and waveforms for the SRAM Read operation.

L/W for Pass=2/8, NMOS=2/16, PMOS=2/4
EXAMPLE - SPICE FOR SRAM READ

Waveforms for the SRAM READ operation.
REFERENCES

7. ICCAP Manual, Hewlet Packard
8. PSpice Users Guide.